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1. Introduction.

There are more than 1700 satellites orbiting the earth, some 150,000 km away. They
send photos and other data to Earth. Most satellites are American. (quote from National
Geographic, February 2018).

This tutorial describes the reception of the NOAA satellites, which transmit an analog
signal also called APT (Automatic Picture Transmission).

Currently, three US NOAA weather satellites are active, orbiting the earth at a sloppy
850-900 Km. They are so-called polar satellites that orbit the Earth via the North and
South poles.

The NOAA satellites send analog signals to Earth in the 137 Mhz segment and are
convertible for us amateurs into pictures of the weather that are fairly easy to receive
given the "low" satellite altitude.

Currently there are three NOAA satellites active and receivable on:

e NOAA 15 -137.6200 MHz launch date: May 13, 1998
e NOAA 18 -137.9125 MHz launch date: May 20, 2005
e NOAA 19 -137.1000 MHz launch date: February 5, 2009

At a mission duration of 2 years, the three satellites are still spinning. How long will their
signals continue to be received, no one can say yet.

You need three free downloadable programs for that, namely: 'SDRSharp’, 'WXin-
tolmg' and for part 2: 'Orbitron’'.

This article aims to help everyone receive weather satellite images with a Windows
system as simply as possible with a cheap RTL-SDR (software defined radio) dongle
(USB stick).

The NOAA satellite reception consists of 2 parts:

Part 1 describes the procedure to follow to receive the satellite images using
'SDRSharp’, in combination with 'WXtolmg'. The disadvantage of this is that you have
to be present at the moment that the images can be received to start both programs.
It is best to follow this method first, because it is the most simple method to receive the
satellite photos. You then only use the programs 'SDRSharp’ and 'WXtolmg'. The qual-
ity of the photos, described in both parts, do not differ. | advise you to get some expe-
rience with the simple method, part 1 first.

Part 2 describes the possibility to have 'SDRSharp' started automatically by a third
program called 'Orbitron’. This program also corrects for the doppler effect and is ex-
plained later in this manual..
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PART 1

Hand-controlled reception.

To get the most out of RTL-SDR you need a decent antenna. Make sure to place it
as high as possible against a metal surface for best results.

For weather satellite reception you should think of a QHF or Tun stile antenna, fig.1
and 2, in the range of 137Mhz. Googling on the internet provides sufficient information
about this, also for self-build.

Try it first with a high placed antenna, if the signal is still too weak, then you will have
to buy an expensive LNA, fig.3, and place it close to the antenna as possible.

Figure 1, QHF antenna.
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Whatever components you use, the installation will largely follow the guidelines below.

One of the most daunting aspects of setting up a receiving system for the NOAA
weather satellites is the tedious setup and are:

* Installation of your RTLSDR dongle, fig.4.

* Installation 'SDRSharp'.

» Setup 'SDRSharp'.

* Installation "WXtolmg'.

* Installation '"VB-Cable Virtual Audio Device'.

* Installation 'Orbitron’, part 2.

» Adding the 'DDE Tracker' plugins in 'SDSRSharp’, part 2.
 Set-up 'DDE Tracking' planning, part 2.

» Configure 'Orbitron' to automatically start 'SDRSharp', part 2.

The above topics are discussed one by one.
You must have sufficient skills to perform basic PC operations such as extracting files,
installing software, moving and copying files, and the motivation to learn new software.

RTLSDR dongle. (Tested on Windows 10/8/7 32/64 Bit)
Please note that the RTL-SDR dongle is not a plug-and-
play device. You must have sufficient skills to perform
basic PC operations such as downloading and extracting
files, installing software, moving and copying files and
the motivation to learn how to use new software. This
tutorial wants to offer support where possible

Currently the most common RTL-SDR dongle, the
R820T/R820T2 is usually for sale for about 25 Euros.
fig.4.

Figure 4, RTL-SDR dongle

In general, at least one PC with a dual-core processor is

required to run most SDR software smoothly. To get the most out of RTL-SDR you
need a decent antenna. Make sure to place it as high as possible against a metal
surface for best results.

Before we start with the installation, put the RTL-SDR dongle aside for a while and you
may not use the usually supplied CD.

NB ! Windows XP platform is not recommended.
You must have the skills to perform basic PC operations such as downloading and

extracting files, installing software, moving and copying files, and have the motivation
to learn new software. This tutorial aims to provide support where possible
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Installation Microsoft.NET 4.6.

SDRSharp is the most commonly used SDR under Windows. This program is rec-
ommended because it fits seamlessly with the RTL-SDR. (RTL chip, Software Defined
Radio).

Do not insert the RTL-SDR dongle into the USB port yet.
Don't use the usually supplied CD!

You must have 'Microsoft.NET 4.6' installed to use 'SDRSharp' later. Follow the link:

https://www.microsoft.com/nl-NL/download/details.aspx?id=49981

Download and install: ‘Microsoft .NET Framework 4.6.1"'

Most Windows 10 PCs already have these installed by default, but computers with
older operating systems may need to install them as well. Note that "NET 4.6' is not
compatible with Windows XP. Also note that on some computers you may also need
to install 'Visual C++ Runtime' if it isn't already installed.

Download SDRSharp, (Tested on Windows 10/8/7 32/64 Bit)
First create a new map, | chose 'NOAA-Satellites', but of course

you can come up with another one. “(C: ) NOAA Satellites”. This —
main folder is the folder where all relevant files are located. The :ﬁ-ﬁ
root folder may not be placed in 'Program Files' or 'Program rogram File

Files (x86), fig.5.

Figuur 5, Figure 5, do not use these folders.

Installation, SDRSharp and Orbitron.

An easy way to install “SDRSharp” and “Orbitron” is the “Meteor LRPT Suite.zip” file
from Les Hamilton, [3]. This installs the entire “Orbitron” and “SDRSharp” configuration
in the LRPT folder. This initial situation is a unique opportunity to create a well-func-
tioning system with as few actions as possible. The download link can be found on the
site of Les Hamilton.

http://leshamilton.co.uk/MeteorLRPTSuite.htm

In part 1 we leave the program “Orbitron” undisturbed, it will only be discussed in
part 2.

Both “Orbitron” and “SDRSharp” are standalone programs. They can be run from any
folder on any drive on your computer, as all their configuration files, data files and DLLs
etc. reside in their own folders, not hidden in the depths of Windows. Extract the “Me-
teor-LRPT-Suite.1.8b.zip” file and put the extracted “LRPT” folder containing all files in
the Meteor-Satellites folder. From there, delete the “LRPT Decoder’ and “QPSK”
folder, fig.6, as these are unnecessary for our purpose.


https://www.microsoft.com/nl-NL/download/details.aspx?id=49981
http://leshamilton.co.uk/MeteorLRPTSuite.htm
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“‘Meteor-LRPT-Suite.1.8b.zip” is actually intended for the installation of another satel-
lite, but because it considerably simplifies the installation, this method was chosen,
after which a number of irrelevant folders are removed.

pc ¥ Acer(C) » MeteorGIS-5atellisten » LRPT »

s
Maam Gew
H—ER-PI—GI-eeo-d-er 12-1
Orbitron 12-1
L4
[ F-ePsH— 12-1
SDRShar 12-1
1 p

Figure 6, folder configuration

[z Read the tutorial carefully, it seems like quite an undertaking, but it is not that
bad. Once everything is working you can start the recording process in two or
three clicks, do other things, the program will do the rest. Later in the day you
can retrieve and edit the recording.

Installation of your RTL-SDR dongel, [4].

Connect your RTL-SDR USB dongle !

With recent Windows 10 (Home Edition) installations, a driver is automatically installed
by Windows immediately when you insert the SDR dongle and therefore the installation
will not work.

To install the RTL drivers for your dongle, you still need to start “Zadig”. (You can find
the “Zadig” file in the “SDRSharp” folder.

In that case, run “Zedge” like this:

- Start “Zadig”, (run as administrator!).

- Click on “Options”.

- Click on “List All Devices”.

- Click again on “Options”, uncheck “Ignore Hubs or Composite Parents”, fig.7.
- Replace Driver

- Select RTL2838UHIDIR.

H 13 H . 1) E zadig
- Click on “Reinstall Driver”.

Device Options Help
»  List All Devices

When you're done with that, check again under UsBR  Ignare Hubs or Compasite Parents
"Device Manager" in "USB Devices" to see if the / w | Create a Catalag File
driver is there. Criver e Sign Catalog & Install Autogenerated Certificate
usa o Advanced Mode
Lag Verbosety

WD

Figure7, “ Ignore Hubs or Compostie” uncheck.
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There you will find the Windows USB Receiver driver and the RTL238UHIDIR driver

suitable for our purpose, fig.8. § Universal Serial Bus-controllers
v § USB-apparaten
§ RTL2333UHIDIR
§ USB Receiver

Figure 8, RTL2838, UHIDIR present..

If your dongle has not been pre-provisioned with a driver by Windows10, follow the
exact order above, except that you do not uncheck “Ignore Hubs or Compo-site Par-
ents”. Click on “Reinstall Driver”, fig.9.

= Zadig
Device Qptions  Help

| {RTL 283FUHIDIR

=1
Driver [ winUSE (v6.1.7600.16365) | - [winuse (vs.1.7600. 15365) =
S Reinstall Driver hd
thD'—IE

Figuur 9, Reinstall Driver.

Note that if you plug the dongle into a different USB port, you may need to run “za-
dig.exe” again. So, the installation of “SDRSharp” is now complete.
Finally, we're going to do a few more settings.

e From “NOAA-Satellites” folder, copy the “SDRSharp” startup file, fig.10, and put it
on your desktop, fig.11, then run SDRSharp.exe.

|2 SDRSharp.DDETracker.dll
%] SDRSharp.DMR.dII
E SDHﬁEFF.E}:E

1 CNRMIacn cue T anfia
Figure 10, SDRSharp.

Figure 11, SDRSharp on your desktop.
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SDRSharp settings.

— ﬁ ) 37.100.000 o TESTY

Source: RTL-5DR (USE)
Radic

Audia

AGC

FFT Display

Audio Notse Reduction ®
IF Makse Reduction
Basehand Moise Blanker *
Demodulator Moize Blanker *
Recording *

Zoom FFT*

Band Plan *

Frequency Manager
Signal Diagnostics *
Tracking DIDE Client v1.2

Yy ¥ ¥r¥¥ ¥y ¥y vy ¥y ¥y Y Y%2UYTY

Figure 12, SDRSharp window with detail settings window

e Your RTL-SDR software radio must be set up before you can receive signals.
Now first select your (USB) dongle in the “SDRSharp” window, fig.12.

— Bt-1LD

RTL-3DR (USB) W

AIRSPY
HarkBE

[Uoh) Figure 13, select your dongle.
FIL-aUR [ TLF)
FUNcube Dongle Pro
FUMNeube Dongle Pro+
SoftRock (S570)
RFSPACE SDR-G (USB)

[ | sl i YT sl Y PONTCORPRY [ [y 5 (PR S

Important! don't forget to also adjust the RF Gain settings by clicking the Configure
Source button. , fig.13. By default, the RF-Gain is set to zero.
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With a gain of zero, you probably won't receive anything. Therefore, increase the RF
Gain to receive the NOAA signals, fig.14. Later when receiving NOAA satellites, do not
set the RF Gain too high because of inter-modulation of any nearby signals.

RTL-50DFR Controller el
Dervice RE20T
senenc RTL2EAZ En
Sampla Rate
2.4 M5PS w
Sampling Maods

ASOrSUre ST

[ Offaet Tuning

[ RTL AGC

] Tuner AGC

RF Gain 13,7 dB
Frequency correction (ppm) 235

Closa
I —

Figure 14, RF Gain setting.

» In the Radio tab settings set the reception mode to: Kl

also be useful to check Snap to Grid.
@®WFM O DSE OCwW O RAW

= The Doppler effect ensures that the signal does not g 0-
stay at the correct frequency. In order to receive the -
entire passage recording properly, you can set the e Order
filter bandwidth to 36 kHz, provided there are no 3200012 1002
nearby interfering signals in the immediate vicinity. ELE

505 1000 =
FM Stereo [] Step Size
5 Grid ~
Figure 15, Radio settings. rep o 100Ktz
Correct 1Q
Swap | &Q []

The Frequency Manager tab allows you to pre-program reception frequencies of
various satellites to later select the desired satellite with a simple click. Run
'SDRSharp' and click on Frequency Manager.
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As you can see in fig.16, you have three options to use. Select New, give Group a
name and fill in the required data from the first NOAA, also fig.16. (BW is the desired
bandwidth).

—— — ¥ Frequency Manager ™
- an

T="TrETe T MNew [ Edit X Delete

=y Frpeery ¥ | Edit Ertry Information X Group: [All Groups] ~
Salsct s enistng GroUD of ST & NEW QIOUD NEms

HOAA_1% (137,620 Mets m| — o o [] Show on spectrum

HOAA_18 137,9125 MHz O . |mM.15 | Mame FI'E-'I:]LIE-'I'IC}'
Frequency: 127 £30 0002 ATS 126,030 MHz
2T 1376200001 NOAA-19 137,100 MHz
S s NOAA-15 137,620 MHz
Filter Bt 35000
. o NOAA-18 1379125 MHz

Fiagu I
[ r::t Cancel |

Figure 17, Frequency Manager
Figure 16, NOAA preset frequencies.

Click OK, and repeat these actions for the next NOAA. If you have completed every-
thing to your satisfaction you will find the three satellites under Group: NOAA, fig.17.
Clicking on one of them will automatically set the VFO to the correct frequency and
bandwidth in the graphical window.Another point to pay attention to is the RTL-SDR
dongle frequency deviation. These dongles are relatively cheap because they are
mass-produced, with the result that each dongle has a different frequency deviation.
An ATIS frequency (Automatic Terminal Information Service) is useful for accurately
calibrating your RTL-SDR Dongle using the Tuner Correction option of the RTL Con-
troller. You can now make the correction, as shown in figures 18 through 20.

| live near Eindhoven Airport and find an ATIS signal at 126,030 Hz to which | can fine-
tune.

FTL-5DR Corntielle x

- Deevme FERT
Spmgle Rl
| Tuner correction (ppm) 14me2s
Caymplang Mocs
i Use SpyVerter for HF ] S
1 SpyVerter correction (ppm) 0,002 [ Ot Turinyg
[ RTL AGC
[ Terss A5
Clese = e
"'-l.-'._.'n"l"'."*.l.,l.""-" Wi Al i |
Figure 19, Tuner correction dongel. T T @

Figure 18, Atis signal. . |

Figure 20, Frequency correction.
You can create another Group for the ATIS setting and specify the correct settings in
it. If you want to see them all, select All Groups, fig.17. These settings remain in effect,
S0 you do not need to save them.
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Download and install VB-Cable Virtual Audio Device.
This software is necessary to enable a virtual audio connection between “SDRSharp”
and the “WXtolmg” program, fig.21. Download and install this program from the site:

https://www.vb-audio.com/Cable

¢y VB-AUDIO Software

Audio- Mecharic & JSowund WBreeder

News Audio Apps Audio Pro Support Developers WebShop

I\."irtualAudioCabIe l Voicemeeter } Banana } VBAN } Spectralissime }

Playback |

Select a playback device below to modify its settings: “B-cnnli “Irt“al nl""n neulce'

é CABLE Input VB-CABLE is a virtual audio device working as virtual audio

VB-Audio Virtual Cable cable. All signals coming in the CABLE input is going to the
CABLE output. Then It becomes simple to make computer
audio recording or to connect a player application to a
recorder one.

F#~ Ready

. [ Recording k

Select a recording device below to modify its settings:

Install VB-CABLE Driver (Donationware)
Virtual Audio MME, DX, KS, WDM Device Driver (XP to WIN10 32/64 bits)

CABLE Output VBCABLE_Driver_Pack43.zip (1.09 .VlB - OCT 2015)
( R VB_Audio Virtual Cable to download from alternative web site.
| Mo Ready

i

INSTALLATION: Extract all files from the ZIP and run Setup Program in
Administrator Mode (Reboot after installation or de-installation)

Figure 21, Download VB-Audio.

After installing VB-Audio Cable, open 'SDRSharp' and select the virtual audio line op-
tion from the Audio Output drop-down list, fig.22.

Samplerate 48000 sample/sec
Input [MME] Microsoft-geluic
Output [MME] Microsoft-geluic -

MME] Microsoft-geluidstoewijzing - Output
MME] CABLE Input (VB-Audio Virtual C

: : [MME] Luidsprekers (Realtek High Defi
[ Unity Gain [Windows DirectSound] Primair geluidsstuurprogramma
[Windows DirectSound] CABLE Input (VB-Audio Virtual Cable)
[Windows DirectSound] Luidsprekers (Realtek High Definition /
[AS10] Realtel: ASIO

Figure 22, installation VB-Audiokable.

Latency (ms)
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Download: Wxtolmg and intallation.

In short: 'WXtolmg' is, in collaboration with 'SDRSharp’, a program that converts the
received NOAA signals into images and can also predict the times and frequencies of
the NOAA satellite transitions.

There is also a paid version of 'WXtolmg' which offers more features, but it is not re-
quired for use with RTL-SDR dongle. Unfortunately the original website is down. For-
tunately, the Windows version can still be downloaded from the ar-chive.org site:

https://web.archive.org/web/20171209052450/http://www.wxtoimg.com:80/downloads/

An extensive (English) manual of 'WXtolmg', in which all options are explained, can
be found under:

https://www.wraase.de/download/wxtoimag/wxqgui.pdf

Install WXtolmg.
e Click on profit21011.exe
e Allow Windows to download this program: “yes”.
e Welcome to WXtolmg: “next”.
e License agreement: tick | agree and click on “Next”.
e Destination folder: Brows: C:\NOAA-Satellites\WXtolmg and “Next”.
e WXtolmg successfully installed !: “finished” .

Settings WXtolmg.
To let 'WXtolmg' and 'SDRSharp’' communicate with each other, you need to make the
following settings:

Open “WXtolmg” and go to “Options Ground Station Location”, fig.23. Enter your city
and country there, fig.24, or if your city is not listed, enter the exact latitude and longi-
tude.
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n Witolmg [Freeware edition] H Witelmg: Ground Station Location — x0T

File Satellite Enhancements Options  Projection  Image He

i City: |Eindh0\ren

Use other sensor Country: |Nether|ands

Disable PLL Lockup Lat/Lon |

Show All

Crop telemetry Enter City and Country and click Lookup
Resync Lat/Lon or enter latitude and longitude in

degrees and fractions of degrees. HNorth and

DlsableMapOgerlay east should be entered as positive numbers,

v Despeckle south and west as negative numbers (example:
Contrast 3 enter 45 degrees 30 minutes west as -45.500).
llluminaticn Compensation * -

- Latitude: 5143

Gamma 4

Sharpen ¥ Longitude:  |5.3

Active APT Satellites... Altitude (meters): 5.0

Internet Options... I™ UseGPS on comt: _.| at 4800 — | baud
Recording Options...

Aute Processing Options... I™ Set PC clock from GPS (if use GPS enabled)
Map Overlay Options...

Text Options...

Projection Options...

Image and Movie Options...

Cancell

File Names and Locations...

GUI Options... . , ;
e Figure 24, entering your location.

Factory Defaults...

Save Options

Figure 23, location of your station tab
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Recording.

ﬂ Witolmg

File Satellite Enhancements Options Projection  Image  Help

Image

Figure 24, main menu

In 'WXtolmg' choose the installed VB-Audio Virtual. To do this go to Options (fig.24) >
> Recording Options, making sure the correct device is selected from the sound card
option. Here you can also check Record only when active APT satellites are overhead.
You can reduce the default values if you have an antenna with a wide view or if you
find that 'WXtolmg' stops recording too early or doesn't start fast enough. In the begin-
ning, keep the default values 20 and 8, fig. 24a.

B Wxtelmg: Recording Options — >

- Record using WEFAX start/stop tones (for geostationary satellites on 1.6GHz)

{s Record only when active APT satellites are overhead

with maximum elevation above (degrees)

record only when satellite is above (degrees)

and require nothing —!

M

Commeon recording options: receiver type none —
soundecard CABLE Qutput (VB-Audio Virtual — | Advanced...
e 1
sample bits = EEER e e Bl al receiver port COMT:
Microfoon (Realtek High Definit
antenna type Device 2 receiver baud rate receiver default — |
Device 3
Aziumuth-Elevation Rotor Control: Device 4
Device 5
rotor type Device B rotor port none =
Device 7
park azimuth/elevation Device 8 rotor baud rate controller default —! ‘
Device 8

Device 10 - I
Device 11 ance

Figure 24a, selectionCable Output.
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Update Kepler, (TLE) files.
Beforehand: what does TLE mean and what is the purpose of TLE?

Very briefly:

TLE is a standard mathematical model for describing the orbit of a satellite. TLE is
short for: Two Line Elements and are processed in a computer program, which pro-
vides predictions for the viewing time and position of the satellite. The program deter-
mines the location of selected satellites above the horizon from a chosen observation
location.

Now you will also want to update the Kepler files called. These files contain information
about satellite locations and pass times. They need to be updated regularly because
satellites drift in time of their orbit.

Go to File Update Keplers. Make sure you have an internet connection for the update.

Satellite pass times.
Go to File > Satellite Pass List, to find a time when a satellite passes overhead. Also
note the frequency, fig.25.

¥ Witolmg: Satellite Pass List — O s

Look ahead  1week —

Satellite passes for Eindhoven, Hetherlands (51°25'N 5°30'E)
while abowve 8.0 degrees with az maximm elewvation (MEL) owver Z0.0 degrees
from 2017-03-24 19:48:57 West-Eurcopa (standaardtijd) (2017-03-24 18:48:57 UIC) .

2017-03-25 UIC

Satellite Dir MEL Long Local Tims UIC Time Duration Freg
NORR 19 5 &50E 14E 03-25 03:50:24 02:50:24 11:27 137.1000
NORZ 15 5 33w 9w 03-25 05:31:25 04:31:25 10:2% 137.1000
HNORR 15 5 40 186E 03-25 0&:39:08 05:353:08 10:44 137.8200
NORR 18 5 47E 15E 03-25 07:25:25 0&:25:25 11l:233 137.91:25
NORR 15 5 3w TH 03-25 08:15:03 a7: 10:25 137.€200
NORZ 18 5 35W aw 03-25 09:0&6:20 08: 10:4% 137.9125
NORZ 15 N Z235E Z1E 03-25 t45 1z: 10:17 137.1000
NORR 13 N 5TW 1w 03-25 14: 11:41 137.1000
NORR 15 N Z1E Z5E 03-25 15: 8:-43 137.8200
NORZ 18 N Z3E ZZE 03-25 1&: 10:13 137.91:25
NORZ 15 N 799 4E 03-25 17: 11:1% 137.€200
NORR 18 N &0W 1w 03-25 17:5 1l:44 137.91:25

2017-03-Ze UIC

Satellitce Dir MEL Long Local Time UTC Time Duration Fregq
HORR 15 5 41E 17E 03-2¢ 04:3%:02 02:35:02 11:08 137.1000
NORAR 13 5 39w o 03-26 08:19:50 04:1%:50 10:53 137.1000
HORAR 15 5 Z&E Z23E 03-26 07:14:30 05:14:30 9:41 137_6200
HORR 18 5 335E 18E 03-26 08:13:52 06:13:52 11:15 137.3125

=1

4

Figure 25, start and end time of the next satellite.
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AutoRecording.
Go to File > Record and click on Auto Record,

I3 Winsimy Pecess : * | fig.26. The recording, decoding and imaging
C Racond only (show image i ensbied) will start when the satellite appears on your
B Recoed and was peccess horizon, and stop when it is out of sight accord-

7 Create imagels Wrage Sestinge. | ing to the times stated in the satellite Satellite
I Crotemovietd) e SOy ) Pass List. After activating Auto Record, also in
[ Addimages s web page 0 toge Sainge | the bottom line of the “Wxtolmg” screen ap-
Mo Geod Qualty ScanLises 01200y — | pears the message with the start and end time
Rermave suds fies pever with the date of the next satellite pass record-
Rermave ravw imaes pever — ing, fig.26.

Remave mept nevet 4

Fermave images never — |

; : Figure 26, Automatic recording.
Manoal Test | A«:;c] Cancel |

|2017-04-01 19:49 UTC |
|Statu5: waiting for NOAA 19 (southbound 57 E) on 137.1000 MHz at 2017-04-02 02:58:35 UTC...

Figure 27, waiting for the recording start time.
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Start up NOAA recording.

Just before the satellite passage will take place, open 'SDRSharp' and
and click Start. p

When receiving the signal, adjust the Gain so that the horizontal volume bar in the
lower right corner of 'WXtolmg' turns green, fig.28. The photo is built up line by line.

2007-04-07 13:4) UTC IROM W Hee 84" A b7 &0/ 1232 I I | I W

Recoeding NOAA 19 (northbound 64 E) on 137.1000 Mi-z from 13:33:40 UTC... | | T 2|

Figure 28, WXtolmg in receive mode.

In fig.29 you can see what such a NOAA analog signal looks like. You can clearly put
the NOAA signal on the speaker via your sound card. Experiment yourself with the
setting options, including those of your sound card.

1 000.137.101.154 o

, NOAA19 signaal

V2
MJ».M»hWM»MWMMLJ‘MM“W M

Demodutsior Notse Blanker *
Recoeding ©

Zoom FIT ™

Band Plan

Frequency Manager *

> Signal Disgnostics *

¥ Tiascking DDE ClentviZ s

(2 Scheduler
Miumal elevabon 00

»
>
>
| =
>
>
»>
»

Orbitron 3.71

Active NOAA_19_f+] Config

Orbitron connected

Name NOAA_19.[+]
Downlink 137101154 bz
Azimuth 8T

Elevation 205" Optiona

Ev  Mag Beek ZAxm ZEN A

122580078

20180302 160228 NOAA 19(+] =13 U0 ? w2715
20180302 160333 NOAA 19]+] 333 5 ? 24 232 =4

.Figure 29, SDRSharp in receive mode.
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If you have selected Options/Auto Processing Options > Record and autoprocess in
'WXtolmg', you will get a picture as shown in fig.30. The recording stops when the so-
called “duration” time in the stated end time of the Satellite pass list has expired.

With File/Save Image as you can save both the raw and edited image in a folder of
your choice.

111 7H) SR
i

ha

Figure 30, MSA multispectral analysis (NOAA-# 2-4/1-4, met syncpuls colom.

So much for part 1.
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PART 2

Orbitron

There is also an option to make 'SDRSharp’ start up automatically using a third pro-
gram called 'Orbitron'. In this way you do not have to be present at the start of the
images reception.

Why the title (semi)-automatic: '‘Orbitron’ is not able to control 'WXtolmg' as well. You
will therefore have to activate it yourself well in advance with Autorecord.

First a word about SDRSharp's options. When opening '‘SDRsharp' the following basic
setting options are available, see fig. 31.

Audio To enable 'Orbitron' to start 'SDRSharp' at the
AGC correct time, the Tracking DDE Client v1.2 option
must be added, fig. 32.

FFT Display
Audio Moise Reduction *

IF Moise Reduction * Zoom FFT *

Band Plan *

Baseband Noise Blanker *

Demodulator Moise Blanker * Frequency Manager *

Recording *

Signal Diagnostics *

Foom FFT * p Tracking DDE Client v1.2 *

Band Plan *

Figure 32, Add Tracking Option.

[
[
[
[
[
|
|
|
|
|
|

L= c L e
Frequency Manager *

Signal Diagnostics *

Y

Figure 31, basis options.

Download the plugin, DDE tracking + Scheduler plugins from the site below:

http://www.rtl-sdr.ru/page/vse-dostupnye-na-etom-sajte-plaginy-s-kratkim-opisaniem

Place the folder DDE Tracker under the NOAA-Satellites folder, fig.33 and open this
folder, fig.34.

Local Disk SSD (C:) > NOAA-Satellieten > ddetracker

~

> Dezepc » Local Disk 550 (C) » MNOAA-Satellieten » A Naam
- - - ] MagicLine.txt
] NDde.dll €——
dd#racker -] NDde.LICENSE.txt
Orbitron ] readme.txt
© 4D3BSpy.exe (%] SDRSharp.DDETracker.dll €—
airspy.dil "] SDRSharp.LICENSE.MIT

o Airemul alikreate sva

B SDRSharp.PluginsCom.dll g——

Figuur 33, ddetracker. & SDRSharpDriverDDE.exe g—

Figure 34, contents of SDRSharp folder.


http://www.rtl-sdr.ru/page/vse-dostupnye-na-etom-sajte-plaginy-s-kratkim-opisaniem
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Copy the three .DLL files and the .EXE file from the ddetracker folder and paste them
into the 'NOAA-Satellites' folder.

Now open MagicLine.txt and copy the 2 lines below, fig.35.

<add key="DDE Tracking Client"
value="SDRSharp. DDETracker.DdeTrackingPlugin, SDRSharp DDE Tracker" /=

Figure 35, contents of Magicline.txt

With Word or another text editor open Plugins.xml from the 'NOAA-Satellites' folder
and paste these 2 lines somewhere at the bottom between the lines:
<frontendPlugins> and </frontendPlugins>, fig.36.

- N LEI_ L'J_EI_ilLEJ.Ll_rl' L'J.G.].LG.HEJ_
value="SDRSharp.FrequencyManager. FrequencyManagerFlugin, SDRSharp.
FrequencyManager™ /=

<add key="Signal Diagnostics"
value="8DRSharp.Diagnostics.DiagnosticsPlugin, SDRSharp.Diagnostic
s" /=
<add key="DDE Tracking Client"
value="8DRSharp.DDETracker.DdeTrackingPlugin, SDRSharp.DDETrackser"
=
</sharpPFlugins>

Figure 36, added rules.

3.2. scheduler.

The Scheduler is a script that controls and configures SDRSharp.

Start SDRSharp, select the newly created tab: Tracking DDE Client v1.2* and click on
Config, fig.37.

Make sure you check the Scheduler option in the DDE Tracker plugin. In fact, if you
open 'SDRSharp' from its own folder, and check this option, then close the program
again, it will automatically remain checked.

Vv Tracking DDE Client v1.2 *

Minimal elevation 0.0 =

Config
Figure 37, Check Scheduler and click Config.

Orbitron connected

Name METEOR-M_2
Downlink 137098098 Hz
Azimuth 270.3°

Elevation -48.1° Options
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In the window now displayed, fig.36, the DDE Tracker must be programmed to per-
form the tasks correctly when a NOAA signal is first detected, (AOS: Acquisition of
Signal) and at the end of the passage (LOS: loss of signal). AOS contains the trans-
mit frequency, modulation type and bandwidth, plus the commands to pass the cor-
rected frequency (calculated by 'Orbitron’) to 'SDRSharp'.

3.2.1. Entering the Satellite Name.

Any 'space' character must be replaced by an 'underscore' character. So for example
'NOAA_19' instead of 'NOAA-19'. Even changing the uppercase to lowercase will
cause errors.

3.2.2. Preparation AOS for the Satellite.

Any of the options shown on the right panel can be moved to the center panel using
the arrow keys. The top panel, labeled AOS, relates to the processing of the satellite
signal, fig.38.

The stop commands appear in the LOS window.

x4

Cateiite rare A0S Command exarmple radho_frequency _Hz<137100000> Jevadabie commands

LOS radio_saqueich_On
squeich _OF

o o

Figure 38, the empty AOS DDE Tracker field.

V.

Add the following commands to the AOS and LOS window as shown in fig.39.

Scheduler *
Satellite name ADS Command example: radio_freguency_Hz<137100000= Auailable commands
NOAS_15 radio_Start radio_Start
radio_modulation_type<WFM:> rad!o_Stop .
Add new satellite radio_bandwidth_Hz<36000> rad!o_modulahon_typec::
radio_tracking_frequency_On rc‘lglﬂ_fcel'rter_freqll:llency_Hz <>
: radio_frequency_Hz<137100000: radio_frequency_Hz<»
Delete selected satellite radio_squelch, GF radio_bandwidth_Hzes
radio_squelch_On
. radio_squelch_Off
Satellite radio_squelch_threshold<:
NOAA_1E radio_tracking_frequency_On
NOAA_12 radio_tracking_frequency_Off
NOAA 19 LOS send_tracking_frequency_On

send_tracking_frequency_Off
tracking_frequency_Hz<
start_programm_Path<:

radio_tracking_frequency_Off
radio_Stop

Figure 39, the DDE scheme configured for the NOAA reception.
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Note that there is no Save button. All listings and changes are automatically saved to
a file called DDESchedule.xml, which can be found in the 'NOAA-Satellites folder.
You can now close 'SDRSharp'.

3.3. Orbitron explanation.

Manually acquired NOAA recordings, as described in part 1, can yield very satisfac-
tory results, but improvements are possible. As the satellite approaches your receiv-
ing station and then moves away from you, the frequency will change due to the Dop-
pler effect. The received frequency will increase as it approaches and decrease as it
moves away from you, sometimes as high as 5000Hz. to be

If a means can be found to continuously adjust the Doppler effect during a satellite
pass, the software locking of the signal will rather allow for longer images and be less
susceptible to the effects of local RF interference. The solution is to use a satellite
tracking program such as Sebastian Stoff's Orbitron to drive SDRSharp and feed it with
an updated Doppler corrected frequency throughout the satellite pass. 'Orbitron’ can
be downloaded from:

http://www.stoff.pl/downloads.php

» Dezepc » Local Disk 550 (C:) » MNOAA-Satellieten »

o~

2 Maam

Orbitron
@ 1DsBSpy.exe
2 airspy.dll
v AirspyCalibrate.exe
= AirspyCalibrate.exe.config
# airspyhf.dll
B AstroSpy.exe

[E8 ActrnSnir cve ranfin

Figure 40, the location of Orbitron map.

After installation, the NOAA Satellites folder should look like shown in fig.40.
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3.4. Download Orbitron 3.71.

page 23

Click on 'Orbitron 3.71' Installer, size : 2 MB and then click on orbitron.exe, fig.41.

Orbitron - downloads
home |[downloads| cardware forum guestbook chat links

”

Applications

Newest oimaaly released version of Orbitron (EXE - installer).
Newest offidally released version of Orbitron (ZIP - packed).

Please use this application to make your language version o
other people as soon as you complete your work.

World maps

After download one of ZIP files below, please extract it to Orbit:
the setup (Alt+F5) and choose your new map in World map configu

680 kB, 800x400
810 kB, 1000x504
530 kB, 1000x50(
SLRlE RS | Figure 41, Sebastian Stoff’s URL.
2600 kB, 1440x7
290 kB, 600x360
630 kB, 1000x50(4

100 kB, 600x360
66 kB, 2048x102
819 kB, 2400x124

Additional translations

3.5. Setup Orbitron v3.71.

Fill in the following windows to appear as follows:

¢ Allow save changes: “Yes”.

e Language selection for Setup: your language.

¢ In the welcome window: “Next”.

e Choose destination folder: C:\NOAA-Satellites\Orbitron.

e Which components to check: Orbitron screen saver.

e Select additional tasks: Make a desktop icon tick.

e Preparing installation ready: “Install”.

e Setup installation Orbitron ready: “Finish”, 'Start Orbitron' on

finches.
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After the last setting, 'Orbitron’ will start automatically and the following TLE windows
will appear, fig. 42

l‘ofl Loaded file(s) contains elements older than 30 days.

Please update TLE data for accurate prediction.
Run TLE updater now?

Figure 42, Update TLE, click Yes.

Select Group www.celetrack.com, and check TLE Expiration Date and Mark
AutoUpdate, fig.43.

Setup X

General | Worldmap  TLE updater Ilime synch | Miscellaneous | Extia |

DX BER@

http: //www.celestrak.com/NORAD /elements/cubesat.txt
dmc. txt http: //www. celestrak . com/NORAD /elements/dmc. txt
education. txt http: Z/www.celestrak.com/NORAD /elements/education. txt
engineerning. txt http: //www.celestrak. com/NORAD /elements/engineering. txt
qeo.txt hitp: //www.celestrak.com/NORAD /elements/geo.txt
geodetic.txt http: //www. celestrak.com/NORAD /elements/geodetic. txt
alobalstar. txt http: //www. celestrak.com/NORAD /elements/globalstar. tt
glo-ops. txt http: //www. celestrak. com/NORAD /elements/glo-ops. tat
qoes.txt http: //www.celestrak.com/NORAD Zelements/goes. txt
qgorizont.txt http: //www.celestrak. com/NORAD /elements/gorizont.txt v

[v TLE expiry date (in days): 0 &

¥ Mark this group for autoupdate

Help Ok Cancel | Apply

Figure 43, don't forget to check Mark AutoUpdate!


http://www.celetrack/
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Made Time

* Real lime i+ Logal
5 minutes

™ Srnulation  utc

@s %X 2AE0 BRE X 5 A0

FSUTC +200

lMa'n §isualisation JLocalion §5at/01kt infio §Prediction setup g Frediclion g Rotor/Radio gabout

Figure 44, Click Load TLE.

Select and Open noaa.txt, fig.45.

Openen >
Zoeken in: | Te j Ic_“f{ *
Maam Gewijzigd op 2
=] musson bt £-9-2005 00:00
| nnss.bd £-09-2005 00:00
=] noaa.bdt 6-9-2005 00:00
|=| orbcomm. b f-5- 2000 QR0
=] other.bt £-9-20035 0000 W
£
Bestandspaam: |nu:uaa.tn.'t
Bestandstypen: |Twee regelige element bestanden { TLE, '.Tﬂ Arnuleren

Figure 45, Select and Open noaa.txt.

o

Zonfirm

Loaded file(s) contains elements older than 30 days.
Please update TLE data for accurate prediction,
Run TLE updater now?

Figure 46, Update TLE data.

COSEDS 2106 HIE
COSM0S 2151
COSMD0S 2151 RSB
COSMOS 2180 A8
COEMO0S 2184 RSB
COSHO0S Z219R/8
COSMO0S 2227 RB
COSM0S 2228
COSMO0S 2237 RSB
COSMO0S 2242
COSM0S 2283 RSB
COSMO05 2278
COSM0S 278 RSB
CO5MO0S 2257 A/E
C5L4RM
DELTA 1 R/E
DELTA 2 R/B)
EMVISAT

IDEFELAARME 427
INFORMATOR 1 R/E
INTERCOSMOS 24
INTERCOSMOS 24 R/B
INTERCOSMOS 26
|;.IIT_:‘[RED€M 0s %RE
1515 1
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Updating completed! >

Start downloading: hitp: A Awew. celestrak. comdMORAD felements te-new. bt ~
Download OF!

Start downloading: http:dAeene. celestrak. comd/MORAD felements visual bt

Download QK

Start downloading: http: £ Aeee. celestrak. comdMORAD felements/weather bt

Diownload OF)

Start downloading: hitp:Awen. celestrak, com/MORAD felement s -comm, bt

Diownload OF)

|Ipdating completed, 33 new TLE file(z], 33 # 33 file(s) downloaded.

Figure 47, update ready.

If it fills the entire screen, press [Alt + Enter] to shrink it, fig. 48.

Fd Orbitron 3.71 = O X

NOWA T[]
NOAA 2 1TOS-D) [
[al-7-%

MOAA 15 [B
." HOAA 15 [B] .

Tomerc 186107 E. 3027 N

* Real time + Local

T Simulation  UTC NORRTIL) W

QT RFEO0 BREX [ 2O

M air & Vitialization g Location § 5tk info § Predction setup § Prediction § B ober A adio § dbaout

Figure 48, normal size window and check the three NOAAs.
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3.7 Configureren van de DDE Tracker Plugin in Orbitron.
Now close 'Orbitron' and then open the file ‘Setup.cfg’ in the config folder of '‘Orbitron’

with a text editor, fig.49.

C:\NOAA-Satellieten\Orbitron\Config

| | Radio.his
| Red.owm
B Setup.cfg

| Standard.owm
Figure 49, Customizing Setup.cfg.

] I I'ZF! mMmam

Add to that the next two lines, fig.50 and 51.
[Drivers]
SDRSharp =C:\NOARA-Satellieten\SDRSharp.exe
Figure 50, add in Setup.cfg

IgNoreMag L TUNKNOWI—U
Calculation=l1
Mode=0

[Driver=]
SDRSharp =C:\NOAA-Satellieten\SCRSharp.exe

[8atellites]
TLEFiles=Tle\noaa.txt
Tracked 1=33591;25338
Active=33591

All1=0

Figure 51, Orbitron now references SDRSharp.

Save setup.cfg. From 'Orbitron’ you will soon be able to start 'SDRShar'p, fig.52.

Copy Orbitron.exe to your desktop, fig.53.

Deze pc » Local Disk 550 (C:) » MOAA-Satellieten > Orbitron »

#

el Maam

Config
Data
Help
Help.plk
Lang
Motes
Output
Tle
| ] files.cre
|=| history.te .
%Orbitrnn.exe -:] rbitroms

read_rme.bd

Figure 53, Orbitron on your desktop.

|=| testeret
H unins000.dat
ﬁ?ﬂ unins000.exe

Figuur 52, Orbitron .exe.
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3.8. Set-up Orbitron.
From ‘General, ‘ settings’ %2 can be made via various tabs, fig.54 and next.

Algemeen.

tod Ti
o [20217027 17.22.34 "
* Real ime {« Local
|5 J|minutes J
i Simulation ~ UTC

@iﬁ;lillﬂ‘@ﬂﬂ BEMX 5 -
EMain i‘-.fisualisatinn iLu:u:atiu:un iS at/Orhit info iF’redictiDn zetlp iF’redictiDn iFE atar/R adini.-’-‘-.bu::ut_?_‘

Figure 54, General Window.

* Set your time zone, fig.55.

First, make sure your computer clock is correct for your time zone. Absolute accuracy
is not crucial, but should indicate true time within seconds. It's a good idea to check
that regularly, or use software to maintain accuracy.

If your PC clock is not set to the local time, open the General tab and insert a correc-
tion for the local time.

Setup *

General lﬂurld map | TLE wpdater | Time zynch Miscellaneuus] Extra ]

BaADec! autput LandLat aukput Lacal time
" 0,0000° & 0.0000° Url-2i
| _tuto | |
{* Ok[*] 00" 00" " o o0 oot v Autodstect
Behaviour Drate
F t
[~ Check for new wversion and messages ome
Yy bk DD vl
[~ TLE update confirmation
S eparatar
[v Save profile on exit - dash - |

I Exit canfimation Example: 2003-01-30

Help Ok Cancel Apply |

Figure 55, setting your local time.
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» World map, fig.56.

You can choose from different cards. The Colored option is a good option.

Setup >

General orldmap | TLE updater | Time synch] Miscellanenus] Extra ]

Colars

Preset

Map image
| Coloured J

Sat icon

|Star J

JUBLUNE
BUOUON

Help Ok LCancel || Apply

e Time synchronization, choose your NTP server fig.57.

Setup x

Eeneral] Wworld map] TLE updater Time synch lMisceIIaneuus] Extra ]

MNTP zerver
BE ntp2.belbone. be j @ @

[f pou have a firewall installed, note that
Orhitron uzes UOP connection an part 123 of server.

Synchronization status

[ Synchronize PC clock, when Orbitran starts

[w |gnore received time when difference iz greater than 1 pear

Help Ok Cancel Apply |‘

Figure 57, Settings Window > Synchronization Time.
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e Miscellaneous.

If “Play sound” is checked, an alarm will sound as soon as the satellite rises above

your horizon, fig.58.

Setup

Eeneral] wiorld map | TLE updater | Time synch  Miscellaneous l Extra ]

R adar viewpart

Badar backaground image

-
0 | Fadar viewpart rotation

[ lrwert B4 directions on radar

Language

* Englizh [Default]

- &

Your language iz HOT on lizt?
Became an Orbitran translatarl

ADS notification

0 5 Satellite elevation limit (deg)

[w Show notice

[w Play zound
|Data"-.5 nd_07.waw

W

Perzonalization

[ User working directory

-

Help

Figure 58, Settings Window Miscellaneous.

e Extra.

Ok LCancel || Apply |

Check the last option AOS message: make this satellite active, fig.59.

Setup

[v Save extended map zethings

[ Save extended interface settings

[w Fullinteractive mode for viewport

[v Automatic 'Sat on rack' pozition

[ Default mouze cursor

[ High rezolution groundzky track

[ Uze default direction letters (M E 5w
[ Image exporter ¢ auto screen shot

[v JPEG format for screen shots

ot

Eeneral] Whorld map] TLE updater | Time s_unu:h] Mizcellaneous  Extra l

v Show application hints

[ Hide " tab from battom panels

[ Woon rotation for zouthern hemizphere
[ Dedgres zumbol for Bigh charzet

[ Printer: Don't use highlight

[ Printer: Usze raw autput

[ ScrSaver Tum back time if TLE expired
[ Autostart Raotor/R adio driver

v A05 Motification: Make zatellite active

Help

Figure 59, Window> Extra.

Ok Lancel Apply
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e Location.

In the 'Orbitron’ main screen, open Location and select your city name. If it is not listed
in the menu, you will need to enter these latitude and longitude coordinates manually,
fig.60. Don't forget to click Choose.

Eindhoven: 5.4770° E, 51.4448° N 2021-10-27 17:51:08 {UTC +2:00)

Name A b st
|Eindhoven ——

Sigh Grdlocator  Altibeds [m) Update

Eindhoven
a El Faiyum
LIETTVE El Mante

El Pazso

[ Ho21ik 0.0

Longitiade Latiude
|S4770°E [514448°N | Choose I Clear i Elazig

b miry g Wisualization § Location § S at/O0rbit info § Predichion setup § Prediction § Rotor/Fadio § About

Figure 60, your location.

e Rotor/Radio.
In the Dnlink/MHz field, select FM-W, fig.61.

Orbitron 3.71

GOES 16
GOES 17
HIMAWARI-8
HIMAWARI-S
METEOR-M 1
METEOR-M 2
METEOR-M2 2
METEOSAT-10 (MSG-3)
METEOSAT-11 (MSG-4)
METEOSAT-8 (MSG-1)
METEOSAT-9 MSG-2)
METOP-A
METOP-B
METOP-C

v

v NOAA TS

v NOAA 1S
NOAA 20
SUOMI NPP

OS5 1552

Eindhoven : 5.4770° E, 51.4448"

NOAA 19
Azimuth nink/MHz || Receive/doppler IDnllnk mode Driver

[1075 137.100000 ~ 1 [137.102557 I[FM-W ~|| [soRshap | B

Elevation Uplnk/MHz Transmit/doppler  Uplink mode Object
[20 [145000 o] [1aa997295 | > | [saele =8

Choose driver and run

Main 3 Visuahisation 3 Location 4 5at/0rbR info 4 Prediction setup 2 Prediction § Rotor/Radio g About

Q4 2\ 88 5000 S [FA21vml thitran 3 71 - (G 200121005 hu Sahashian Sin

Figure 61, Setting DnLink Mode.
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In the satellites column, on the right, by double clicking on NOAA 15-137,6200 MHz
each of the selected satellites you indicate the correspond- ~ NOAA18-137,9125 MHz
ing Downlink frequency in the DIinl/MHz window. These val- NOAA 19-137,1000 MH:
ues are automatically saved and adjusted slightly depend-

ing on the Doppler effect.

Finally, select the SDRSharp driver from the drop-down list, fig.60. You should find
an entry to SDRSharp there (added by you, during a previous 'Orbitron’ setup.cfg file
modification).

Note: If you find that the 'SDRSharp' driver is not added to the drop-down list, the
most common cause of the problem is installing "Orbitron’ in the Program Files folder
(x86), or you have a made a mistake in the Orbitron / Config folder, with the addition
in setup.cfg.

4. Start-up procedure.

4.1 Automatic NOAA satellite recording.

All settings you have made before will remain active.

Everything is now ready to display the NOAA satellite images, fully automatic and
Doppler frequency corrected, with 'WXtolIMG' in 2 steps.

Step 1. Orbitron. SANOQIAMG

Now fire up 'Orbitron’ and select the Rotor/Radio tab. [FDHSharp j %
Click the icon next to Driver: 'SDRSharp’, fig.62 and

wait a few seconds until 'SDRSharp' appears on the Woorwerp

screen. | Satelliet ~ 5

Figure 62, Driver SDRSharp.
Predict the NOAA satellite transitions.
Click on the Prediction tab and then on Predict.
After the download is complete, confirm with OK, fig.63.

Klaar!!

Zoek penode: 20017-03-2015:15:19 Tidzone: UTC +1:00
2017-03-2315:15:19 | aantal passages: 26
Lokatie: Eindhoven [5.4770° 0, 51.4448° N)

Gevolgde sat. 1/1; METEOR-M 2 Passages: 26
AEEEEREEEEEEENEEEEEEEEEEEEEEEEEEEN

Totale voortgang: Klaarl
AEREEENENENNENENEEEEEEEEEEEEEEEEEED

Sorterer: Klaar!

NNNNNNNNNNNANANNANNN NN | | oo ssages being loaded.

The new window shows all the required orbital information from the NOAAs, fig.64.
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Time - LOC

2021-10-27 18:44:50

2021-10-27 18:47:09
2021-10-27 15:43:28

2021-10-27 19:49:29
2021-10-27 18:56:30

L e R R R b I R e T e T

Satellite Azm Elv  Mag HRange S.Azm  SElv o~ Paszes
MHO&s 13

Flares
MOAMN 18 18.6 10 78 3382 2851 48
MO&AM 18 14 oo &0 3514 2BEE B2
MOAMN 15 1216 00 73 3387 25BE A2
MOAN 15 567 235 B8 1684 28BS B3

R TN Ao - "o - r LN Kalnl e e =~

According to the timetable, fig.63, 'Orbitron’ will automatically start up 'SDRSharp' at
5:41 PM and 7 seconds at the previously set frequency of the NOAA1S5.

Step 2. WXtoIMG

Run ‘WXtolmg’.

n Wikeimy Fecesd

f

D)

x
Record only (thow image d enabled)
acerd ané sste preomms The 'WXtolmg settings are already described
R khats luaped e S in part 1. Finally: Select AutoRecord, fig.65.
I~ Creste moviels) Mone M_ng-._ {

[T Addimagests web page Web Page Semvnge.

Mo Geod Qualty Scan Lines 0200y —

Femave suded fes
Rermdve rew imajges
Remaove mapt

Fermave mages

Figuur 65, WXtolmg in Auto Record.

Manoal Test -\(u;&’ Cu\m{

After the above steps you can do other things. At a later time you can then save the
photo, visible in the WXtolmg window.

Finally, close 'Orbitron’', SDRSharp will be closed automatically.
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H—

H=— 7= Some points to keep in mind with this method:

o

e |If you do not save the photo on 'WXtolmg' in time, the next recording will be
started automatically, which unfortunately overwrites the first photo and you will
lose it. In this case, fig.70, the NOAA15 picture will be overwritten by the
NOAA19 satellite.

e Make sure your computer does not shut down prematurely, below you can see
what you can do about it.

e Don't forget to start 'WXtolmg' after 'Orbitron’ in Autorecord mode.
¢ 'WXtolmg' does not start automatically.

Again: It can be useful to have your screen turn off a little later. It would be a shame if
the recording is in progress, your PC will be shut down.

Start / Configuration / Energy management > Set sleep time, (Windows10)




